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Foreword

In this tutorial, we provide various case studies, which are from easy to difficult and combine theory with
practice. We hope to improve users’ CAE skills and techniques with ZWSim.

The tutorial bases on our technical engineers’ years of experience in the industry and ZWSim, which is the
fruit of a lot of efforts and wisdom. We sincerely hope that the tutorial will do help to you, and your precious
advice on it is highly welcomed.

This tutorial is for users who have little or no prior CAE experience. If you are green hands of CAE software,
or if you are a new user of ZWSim, we recommend that you get started with this tutorial. Here you can learn
the basic knowledge and concepts of ZWSim, rapidly master the simple operations and workflows of ZWSim,

and practice simple cases.

Thanks for being our user!

The ZWSim Team
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1 Introduction

Kinetics analysis is one of the main contents of CAE analysis, which is used to study the change of structure
response over time. It is often necessary to consider the influence of damping and inertial effects.

The model shown in Figure 1 is a slab beam with a thickness of 1 mm. One end of the beam is hinged and
one end is simply supported. The upper surface of the beam is subjected to a simple harmonic force with a
frequency of 50 Hz and a magnitude of 10N, and the beam begins to vibrate from rest. Considering Rayleigh
damping in the vibration process, the damping coefficient is @ =0.02, B =0.0001. The calculation adopts the
mode superposition method, and takes the first 5 modes to describe the motion of the object.

Figurel Geometry model

2 Modelling

Help -> More -> Structural -> model

STEP 01| Open the dialog box [Select PDF file];
STEP 02| Select [All Files (*.*)] in [Files of type];

STEP 03| Select the model file [slice.stp] in [\Structural\model] and then click [Open] to complete.
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Figure2  Import model



Dynamic Analysis of a Slab Beam (Mode Superposition) {({{{{{{{{{((

3 Unit setting

Simulation -> Pre-Processing -> Unit Manager

STEP 01 Open the dialog box [Unit Manager];

STEP 02| Select [MMKS] in [Unit System] and then click [OK] to complete.

g Unit Manager B i
Unit System
) Sl (m, kg, s, rad, K} ) IPS (in, lbm, s, deg, F)
() MES (m, kg, 5, deg, C) () FPS (ft, Ibm, 5, deg, F)
() CGS (cm, g, 5. deg, C) () Custom

B MMES (rmm, kg, 5, deg, )
Unit Information

Type Unit Symbol

1 éLength mm

7 Eaee

Figure 3 Unit manager

4 Simulation Task

Simulation -> Simulation Task -> New Structure

STEP 01 Open the dialog box [New Structure];

STEP 02| Select [Linear Transient(Modal)] in [Structural Dynamics] and then click [ v ] to complete.

"4y New Structure R
v X E (O
P Structural Statics

k Modal Analysis

P Heat Transfer
L)

Structural Dynamics

@

! Linear Transient (Modal)

(") Linear Transient (Direct)

) Monlinear Transient

) Harmonic Response (Modal)

) Response Spectrum

Figure4  New structure

5 Analysis Option
ZWStructure -> Base Config -> Task Option
STEP 01| Open the dialog box [Modal Transient Analysis Options];

STEP 02| Set [Number of modes] to 5 in tab [Modal];

STEP 03| Set [Start time] to 0 in tab [General]. Then set [End time] and [Time increment] to 0.1 and 0.0004,
respectively;

STEP 04| Click [Rayleigh damping] in tab [Damping], set [Alpha] to 0.02, set [Beta] to 0.0001;
STEP 05| Click [OK] to complete.
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g4 Modal Transient Analysis Options B ER
Modal General Damping Solution

General Options
Method ZW eigen solver

Nurmber of modes 5

Range of Interest

G T Y R N P

Figure5 Number of modes

& Modal Transient Analysis Options R
Modal General Damping Solution

Selution Time

Start time | 0.000000 End time 0.1 Time increment  0.0004]

Figure 6  General

4 Modal Transient Analysis Options R
Modal General Damping Solution
Viscous Damping
Consider damping element
Note: This is not supported in mode superposition method.
Equivalent Viscous Damping
Rayleigh damping = Alpha*M + Beta*K
Alpha 0.02
Beta 0.0001|
[T] Structural damping = (G/W3)*K or ignored if W3<=0

Overall stru | damping coefficient G _ G000000

Figure 7  Damping

6 Material
Simulation Tree -> Mode superposition1 -> Part -> Geometry Part -> S1(Shell)

STEP 01| Right-click [S1(Shell)] on the simulation tree and then click [Edit Material] to open the dialog box
[Material Library];

STEP 02| Right-click [Local] and then click [Create Material] to open the dialog box [Create Material];
STEP 03| Set the material properties as shown below and name it as “steel”;

STEP 04| Click [OK] in dialog box [Create Material] and then click [OK] in dialog box [Material Library] to
complete.
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o Create Material B ER

¥ Basic

MName steel

Category default

Description
¥ Property

Model Linear Elastic |sotropic -

Narme Value Unit

1 | Elastic Modulus 2.1el1 Nf/m*~2

2 |Poisson's Ratio 0.3

3 |Shear Modulus 80760230769.230774  N/m*2

4 | Mass Density 7800 kg/m*"3

nsile n W

Figure 8 Create material

7 Property

Simulation Tree -> Mode superposition1 -> Part -> Geometry Part -> S1(Shell)

STEP 01| Right-click [S1(Shell)] on the simulation tree and then click [Shell Element Property] to open the
dialog box [Shell Element Property];

STEP 02| Set [Thickness] to 1mm;
STEP 03| Click [ ¥ ] to complete.

Shell Element Property &3
v ] X o)
¥ Required
Thickness 1 sl mm ~ i <
» Optional

Figure9  Shell element property

8 Constraint

Simulation Tree -> Mode superpositionl -> Constraint

STEP 01| Right-click [Constraint] on the simulation tree and then click [User Reference Geometry] to open
the dialog box [User Reference Geometry];

STEP 02| Select [Geometry] in [Object type];

STEP 03| Activate the pick box [Entities] and then pick the the left edge of the slab beam by mouse or
inputting, fixing the translation of X, Y and Z;

STEP 04 Click [ V] to complete;

STEP 05| Activate the pick box [Entities] and then pick the the right edge of the slab beam by mouse or
inputting, fixing the translation of Y and Z;
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STEP 06| Click [ v ] to complete.

/4~ User Reference Geometry &3
v |X|= @

¥ Basic Type

Object type Geometry =
E1 A~

Entities

>
B

¥ Senior Custom

Reference type A @ m Q

Cartesian reference  Default C5Y5_KY @

Cartesian direction  Axis value

X 0 Slmm v b
[ Reverse direction

&y 0 - |mm vl
[| Reverse direction

i 0 Slmm v b
[ Reverse direction

[T] Rotational X 0 > | deg

[ Rotational ¥ 0 2| deg

[ Rotational Z 0 s | deg

P Symbol Setting

/4~ User Reference Geometry &3
v X|E LE
¥ Basic Type
Object type Geometry &
E3 ~
Entities
>
&

¥ Senior Custom

Reference type

#1810 @

Cartesian reference  Default C5Y5_KY &

Cartesian direction Axis value

B % 0 L | mm

Y 0 Slmm v b
|| Reverse direction

¥ z 0 Slmm v b

[ Reverse direction

[ Rotational X 0 - | deg
[T] Rotational ¥ 0 > deg
[ Rotational Z 0 > | deg

P Symbol Setting

9 Load

(a)

Figure 10 User reference geometry

Figure 11 Constraint setting

Simulation Tree -> Mode superposition1 -> Mechanical Load

(b)




Dynamic Analysis of a Slab Beam (Mode Superposition) {({{{{{{{{{((

STEP 01| Right-click [Mechanical Load] on the simulation tree and then click [Force Load] to open the dialog
box [Force Load];

STEP 02| Select the first icon in the type icon [Global direction];

STEP 03| Select [Geometry] in [Object type];

STEP 04| Activate the pick box [Entities] and then pick up the upper surface of the geometry by clicking with
the mouse or typing, the direction is -Z;

STEP 05| Check [Time dependence], select [New Formula] in the drop-down options, and enter the formula
setting window;

STEP 06| Double-click [Expression] in the formula editing window, the formula editing bar appears, enter
cos(18000*t) and click [OK] on the right, then click [OK] below to complete the setting and return
to the [Force Load] dialog box;

STEP 07| Click [ ¥ ] to complete.

5 & Function Expression 2 52
@ Force Load &3
| Mame Formula Field

q ﬁ E’ ﬂ L Description

¥ Required

Independent Time

MName Symbol Unit Minimum Maximum

7 vl Y B e
ffg;;f:x L?:': m\i 1| Time t s

Ob_lECttll"pE Gegmetrf - Denpendent Dimensionless
Entities 1 picked ¥y & Name Unit Bxpression Double-click
1| Dimensionless 0
Value 10 SN T
Expression cosﬂEDDD*ﬂj 0K Cancel
. = )l Filter
Direction 0,0,-1 ¥ ¥ E-
Name Symbol Unit
¥| Time dependence w2 1| Time t s

Mew Formula
b Spatial Distribution Mew Table

P Symbol Setting View

1
oK Cancel

(a) (b)

Figure 12 Force load

Figure 13 Load setting
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10 Mesh

Simulation Tree -> Mode superpositionl -> Mesh

STEP 01| Right-click [Mesh] on the simualtion tree and then click [Create Mesh] to open the dialog box
[Create Mesh];

STEP 02| Set the options as shown below, set [Mesh size] to 2;

STEP 03| Click [ v ] to complete.

& Create Mesh 3
1
v X E o D
¥ Required
Mesh density
Coarse Fine

¥ Parameters
= <GP
W W

- F ird
Mesh size 2 mm oL |

Element type Autoc (Curve/Triangle/Tetrahedron) -
¥ Options

[ Compatible mesh

[] Second order

Split quads into triangles

Minimum circular mesh 2 SE

Figure 14 Create mesh

Figure 15 Mesh

11 Calculation

Simulation Tree -> Mode superposition1 -> Result

STEP 01| Right-click [Result] on the simulation tree and then click [Calculate] to analyze current simulation
task.



Dynamic Analysis of a Slab Beam (Mode Superposition) {({{{{{{{{{((

12 Post-processing

The cloud diagram of results of each time step can be viewed on the tree after calculation, as shown below.

Search
v %" Mode superposition1
v 2 Part
45 Geometry Part
# Contact
“ Connection
%, Constraint
#4 Mechanical Load
O @ Mesh
~ & Result
~ & Increment step: 1- 20, Time: 0.0004 - 0.0
~ @ Increment step: 1, Time : 0.0004
& Element Strain Energy
8 Total Displacements
~ @ Increment step: 2, Time: 0.0008
b Element Strain Energy
& Total Displacements
~ & Increment step: 3, Time
&b Element Strain Energy
& Total Displacements
v & Increment step: 4, Time
Ak Element Strain Energy
Ak Total Displacements
~ @ Increment step: 5, Time
& Element Strain Energy
& Total Displacements
~ @ Increment step: 6, Time
b Flement Strain Energy

ErET i

:0.0012

: 0.0016

:0.002

: 0.0024

&

& - &

L
Hold down <F2> for dynamic viewing.
<F8> or <Shift-roll> to find next valid filter setting.

Total Displacements (mm)
0.05768
!0A05191
0.04615
0.04038
0.03461
50.02884
0.02307
0.0173
£0.01154
IOAOOSTGB

0
Time:0,000400

X
152.048 mm

Figure 16 Result

To view more results, you can use [New Result Display].

- &- @3- &

- - o= O % | § O Layeom -

Model name:slice

Task name:Mode superposition

Plot type:LTD Mode superposition - Total Displacements
Deform factor:231.438171

STEP 01| Right-click [Result] on the simulation tree and then click [New Result Display] to open the dialog
box [New Result Display];

STEP 02| Set the options as shown below, output velocities result cloud diagram;

STEP 03| Click [ ¥ ] to complete.

Search
v %" Mode superposition]
v 2 Part
45 Geometry Part
# Contact
“ Connection
%, Constraint
#4 Mechanical Load
O @ Mesh
~v & Result
~ @ Increment step: 1- 20, Time: 0.0004 - 0.0
~ @ Increment step: 1, Time : 0.0004
&b Element Strain Energy
& Total Displacements
Total Veloities
~ @ Increment step: 2, Time:
&b Element Strain Energy
Ak Total Displacements
v & Increment step: 3, Time:
Ak Element Strain Energy
& Total Displacements
~ @ Increment step: 4, Time:
A Flement Strain Energy
4 Total Displacements
~ @ Increment step: 5, Time:
A Flement Strain Energy
A Total Displacements
~ @ Increment step: 6, Time:

Flarnart Gtrain Frarm:

0.0008

0.0012

0.0016

0.002

0.0024

[ »

E: New Result Display

.
v| X
¥ Display
Type Welocities result
Sub-type Total Velocities

Time step/ frequence/eigen  0.000400

o

¥ Options

Type All

¥ Deform

Coefficient | 224.438169363627 s

Auto

;- &

L
Hold down <F2> for dynamic viewing.
<F8> or <Shift-roll> to find next valid filter setting.

Total Velocities (mm/s)
279.7
!251,8
223.8
195.8
167.8
=139.9
111.9
83.92
5595
IZ?.BT

0
Time:0,000400

X
152.048 mm

Figure 18

- &- @3-

Figure 17 New result display

- - om0 % | Q0 teye -

Model name:slice

Task name:Mode superpositicnl

Plot type:LTD Mode superposition - Total Velocities
Deform factor:231438171

View more results
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ZWStructure ->Result -> New XY Plot
To view the response curve in a specific location, you can use [New XY Plot].
STEP 01| Click [New XY Plot] in the toolbar to open the [New XY Plot] dialog box;

STEP 02| Choose displacement results. Select [At location] in [Options] and then pick some interested nodes
in view area by mouse;

STEP 03| Click [Update response data] to show the results.

™ New XY Plot £3
v | X LiE
¥ Required

Type Displacements result L
Sub-type T3 Displacements &
¥ Options

(") On selected entities
() At nodes/elements number

@ At location

Picked nodes | node(466) E

| Update response data |

Figure 19 New XY plot

(g Result Chart L ER

Line Result
40

30
20
10

@ Mode 466
-10

T3 Displacements

-20
-30

-40
0.0004 0.0253 0.0502 0.0751 0.1

step
#: 0.0707 ¥: 53.3

Figure 20 Response curve



